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* How can | add multiple picturesinto articles?
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 When | click on “Use Editor”, it asks meto enter my Office 2000 CD. Why is
thisand how can | makeit stop?

* General advicefor uploading Microsoft Word documents
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exists?
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*  Which format will subscribersreceive by default: HTML or plain text?
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*  Which e-mail programs support HTML and which do not?

* How many times do you attempt to send an e-mail beforeyou report it as
bounced?

Reporting

When isan e-mail considered “open”?

* Why doesa particular subscriber appear to have opened the e-mail many
times?

* What isagood click-through rate?

* What dothesereporting terms mean?

M arch 2006 Cisco Confidential



Cisco SYSTEmMS

®

Adding Content

How do | hyperlink an e-mail address?
SOLUTION - you can do thisif your articleisin HTML format. There are two methods:

Method 1: Open the online HTML editor. When you enter an e-mail address it should be
automatically hyperlinked. The hyperlink should appear after you click the spacebar or
hit the “Enter” key at the end.

Method 2: Enter the HTML tags yourself. For example, if the e-mail address of the
contact person is bill @abccorp.com, the syntax is as follows:
<a href="mailto:bill @abccorp.com">bill @abccorp.com</a>

Why am | getting session expiration messages when | write articles online?

SOLUTION - if you are composing long articles, we strongly suggest you use a program
like Microsoft Word to do thiswork. Y ou get to use al of the powerful tools (e.g., spell
checking and grammar checking) Word provides and then you can upload the resulting
filedirectly into your newsletter using the “Upload” feature on the Article Entry page.

The timeout period is the same for all users. It is used to manage server resources and
provide an additional level of security. If you prefer to compose your article online, make
sure you save your work often.

While you are editing an article online, awarning message will be displayed if your
browser supports JavaScript and your account has been idle for a certain amount of time.
At thistime, you should save your work and then resume your edits.

If your session expiresin the middle of your work while using the online HTML editor
and you click the “ Save” button, the system will actually try to store your articlein a
temporary file. You will be alerted to this fact in the text of the timeout message. In this
case, the next time you login and return to the HTML editor, alink will appear at the
upper right of the window that allows you to retrieve your most recent work.

At other locations within the service, there may be no way to retrieve the lost text.

Sometimes hitting the back button right after this happens will let you copy the text to the
clipboard so that you can save it to disk—or copy it into another active browser window.
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How do | add alink to another Websiteinside my article?
SOLUTION

Use the Online Editor
The easiest way to do thisisto use the online HTML editor. Thisis accessible through
the Article Entry screen.

Under either the Synopsis or Article Body boxes, click the “Use Editor” button. Once you
arein the editor, highlight the text you want hyperlinked and then click the “Chain Link”
icon in the toolbar at the top of the editor box. In the URL box, enter the Web address to
use as the destination of the link.

UseaBit of HTML

Another way to do thisisto use abit of HTML and make the articleinto an HTML
formatted document. The link syntax is:

<A href="http://www.somewhere.com">Link Text</A>.

This creates alink on the words “Link Text”, which points to the Webpage at
http://www.somewhere.com

Converting from Plain Text

If the articleisin plain text, you can convert it automatically to HTML using the Article
Editor. These conversions will automatically hyperlink any Web addresses contained
within the article (i.e. an address containing the http:// prefix).

Todothis;

* View articles.

» Click thetitle of the article that will contain the link.

* With the format setting at plain text, click the “Use Editor” button.
* AttheArticle Editor, click the“Convert to HTML” button.

* Note how thetext has changed to HTML format. Click “Save”.

» Click “Save” again and go preview the result.

How can | add multiple picturesinto articles?
SOLUTION - hereis how you can add multiple pictures to an article:
STEP 1: Upload the pictures to your account using the File Manager.

STEP 2: Use the online HTML editor to embed the pictures within your article at the
location you would like each picture to appear.
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STEP 1 INSTRUCTIONS:

1. Gotothe Man Menu and select “File Manager”.
2.
3

At the bottom of thefilelist, click “ADD NEW”.
In the Upload section, click “Browse...” to select the picture file on your computer

that you would like to upload (either in GIF or JPEG format).
4.
5.

Choose the picture, click “Open”, then click the “Upload” button.
Repeat this process for each picture.

STEP 2 INSTRUCTIONS:

6.
7. Specify any other display options like alignment, width, and height, and then click

8.

Edit the article that will contain the pictures. Pictures can appear in either the
synopsis or the body of the article.

On the Article Entry screen, make surethe “HTML format” radio button is selected.
Click the “Use Editor” button underneath the area in which the picture will be placed.
Within the online editor, place your cursor at the location where you would like to
insert your picture.

Click the Picture icon in the editor toolbar to display the Image Information window.
The image drop-down list at the top of this window will contain the list of picture
filesin your account.

Choose the picture from this|ist.

“OK”.
Repeat this process for each additional picture you would like to add to the article.

NOTE: If your browser does not support the online HTML editor, you will seeasimple
editor instead. In this case, you can add pictures using HTML tags. The syntax for adding
apictureusing HTML isasfollows:

<img src="http://www.imakenews.com/ACCOUNT_NAME/PICTURE_NAME.GIF"
align="top">

Replace ACCOUNT_NAME with the name of your account and PICTURE_NAME.GIF
with the name of the picture file that has been uploaded through the File Manager. The
value of the “align” parameter can be changed from “top” to “left” or “right” to
determine the picture’ s placement relative to the rest of the text.
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Can | reuse articlesfrom previousissues?

SOLUTION

Configure the Articleto Appear in ALL ISSUES

One way to have the stories appear in multiple issuesisto do the following:

arwbdE

o

Go to the Main Menu.

Select the issue containing the article you want to use.

Click “Articles’ to go to the Article Overview page.

Click on the article that you want to copy into your new newsletter.

At the top of this page, you will see a caption that reads “ISSUE: In which issue
should this article appear?’

Change thisto show in ALL ISSUES. Thiswill allow you to reusethis articlein
another issue.

IMPORTANT NOTE: When an articleis set to appear in ALL ISSUES, any change you
make to the contents of this article will be reflected in all prior and future issues. These
changes (along with any design changes) will also appear in issues that have previously
been published. Only one published pageis created for each article, so posting an issue
that uses this article will cause the corresponding page to be re-posted as well. To prevent
this from happening, use the Copy and Paste feature instead (see below).

Create a Copy of the Article Using the Copy and Paste Feature

Another way to get an article that has been used in one issue to appear in another specific
issue isto copy the article into the “Content Clipboard” and paste it into a new article.

PONPE

Go to the Main Menu.

Select the issue containing the article you want to use.

Click “Articles’ to go to the Article Overview page.

To theright of the article you want to copy, click the “Copy” icon. Thiswill add
the article to the Content Clipboard. A popup window will appear to show you the
contents of the clipboard.

Go back to the Main Menu and select the issue that will contain the copy of this
article.

Go to the Article Overview and click the “Paste” icon located on the upper right
of the page. If there is more than one article in the Content Clipboard, you will be
asked to select the article you would like to paste.

The article entry page will appear containing the contents of the original article.
Make any edits as needed, and then click “Save’.
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When | click on “Use Editor”, it asks me to enter my Office 2000 CD. Why isthis
and how can | makeit stop?

SOLUTION - because the online HTML editor is built upon the DHTML Edit Control
found in Internet Explorer, there are some sharing issues between it and Office 2000.

While Office 2000 doesn’t actually do anything to the files needed for the editor to run, it
thinksthat it is responsible for them. If you click “Cancel” on the error enough times, it
will let you through and you can use the editor.

Below areinstructions that should provide a solution for the issue and keep it from
happening in the future.

1. Click Start > Settings > Control Panel > Add/Remove Programs

2. Highlight Microsoft Office Professiona in thelist.

3. Click “Change” (thiswill pop up the Office Maintenance Window).
4. Click “Add or Remove Fesatures”.

5. Expand the Office Tools Directory.

6. Click the down arrow next to HTML Source Editing.

7. Select “Run from My Computer”.

8. Click “Update Now”.

General advicefor uploading Microsoft Word documents
SOLUTION

Transferring Formatted Content from Microsoft Word

There are severa methods that can be used to transfer formatted content from Microsoft
Word to the system.

The easiest and fastest method is to upload the Word document directly and have the

system convert the document (and all of its embedded images) into an HTML equivalent.
Thisisdone by clicking the “Upload...” button on the Article Entry page.
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To Upload a Word Document:

1. Go to the Article Entry page.

2. Click the“Upload...” button found under either the Short Description/Synopsis or
Article Body edit boxes.

3. Next to the “File to Upload” prompt, click the “Browse” button to select the Word file
from your computer.

4. Once the file has been selected, click the “Upload File” button.

While most formatting options are supported by this method, the conversion process does
not always yield expected or desired results. The robust formatting and style optionsin
Microsoft Word sometimes do not convert properly to their HTML equivalents.

For amore accurate translation of formatting, try using Copy and Paste to transfer
content from an open Word document to the online HTML editor. This method works
better than the conversion process because it takes advantage of certain compatibilities
between Microsoft Word and the online HTML editor (which makes use of Microsoft
component technologies). The only inconvenience of using Copy and Paste is that any
images contained within the Word document may need to be uploaded separately as GIF
or JPEG images and placed manually into the article via the editor.

To Copy and Paste a Word Document:

1. Open the document in Microsoft Word.

2. Go to your browser window, log into your account, and either create anew article or
edit an existing article.

3. On the Article Entry page, choose the HTML (formatted text) option.

4. Click the “Use Editor...” button under either the Short Description/Synopsis or Article
Body input boxes.

5. Switch to the Microsoft Word window containing your document.

6. Use your cursor or mouse to highlight the text of the document, either al of the text or
aportion of it. Do not worry about any pictures. Y ou can highlight them too, but they will
not be transferred at thistime. SHORT CUT: Press CTRL+A to select the whole
document.

7. Select “Copy” from the Edit menu, or press CTRL+C.
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8. Switch back to the online HTML editor window.

9. Put your cursor into the editor, then press CTRL+A (Select All) and then CTRL+V
(Paste).

10. Click “Save’ at the bottom of the editor window to save the formatted text.
11. Click “Save’ at the bottom of the Article Entry page to save the article.
Inserting Images

Any pictures your document contains will not be transferred to the online HTML editor
through the Copy and Paste process. An invisible picture placeholder will be present. If
you click the empty space where the picture was originally positioned, you should see a
rectangle appear around the picture placeholder. Y ou will now want to replace this
placeholder with a GIF or JPEG image that resides within your account.

There are several ways to upload images for use in your article. If you already have GIF
or JPEG formatted image files, you can load these one at atime into your account either
through the File Manager or through the Upload feature within the online HTML editor.

If you do not have the images in your Word document prepared as separate GIF or JPEG
files, you can make use of the Word to HTML conversion process through atemporary
article that automatically converts the embedded pictures into GIF or JPEG equivalents.
Then you can copy these images from one article to another.

To Upload and Embed Pictures from a Word document:

1. Create anew article. Thiswill be atemporary article that is used for loading
documents containing pictures.

2. From the Article Entry page, click the “Upload...” button to select and upload your
Word document.

3. Once the document has been uploaded, click the “Use Editor...” button to edit the
document.

4. From within the online HTML editor you will now want to put all the pictures together
and copy then to the clipboard. There are several ways this can be accomplished:

a Delete dl of the text surrounding the pictures, then press CTRL+A (Select All)
followed by CTRL+C (Copy).

b. Or, click and drag all of the pictures you need to the top of the editor. Then,
highlight only the pictures and press CTRL+C (Copy).
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5. Click “ Sa\)e” to temporarily save your changes to the temporary article (in case you
need to copy additional images). Then, click “Save” again on the Article Entry page.

6. Go back to the original article (that is awaiting the images) and click “Use Editor...” to
edit it with the online HTML editor.

7. Within the online editor, put your cursor at the top or bottom of the text and then press
CTRL+V (Paste). The pictures will now appear within the editor and are ready for
placement within the article.

8. Move pictures to the proper locations within the article. To do this, click once on the
picture and then press CTRL+X (Cut). Find the picture placeholder within the formatted
text that corresponds to this picture. Click to select the placeholder and then press
CTRL+V (Paste). Repeat this process for each picture.

9. When you are done, click “Save” on the editor window and at the bottom of the Article
Entry page.

Y ou can re-use the temporary article for other documents you need to upload. Once you
have successfully embedded al of the pictures, you can delete the temporary article.

Managing Subscribers

How can | import addresses from Outlook?

SOLUTION

To import an Outlook Express address book, follow these steps:

Open Outlook Express.

Under the File menu, select Export -> Address Book.

Choose “Text File” asthe file format.

Save thisfile and then open it in Microsoft Excel (or similar program). The e-mail
addresses from the address book are listed in a column titled “E-mail”. These are
the addresses, which you can import to your newsletter account.

Highlight and copy (CTRL+C) all of the addresses in this column to the clipboard
(excluding the label at the top).

Log into your newsletter account.

Click on the “Subscribers’ link at the bottom of the Main Menu.

Click on the“IMPORT SUBSCRIBER LIST” link.

Put the cursor in the E-mail Addresses box and paste the e-mail addresses you
copied (CTRL+V).

10. Optionally specify asub-list or short source code.

11. Click “Submit” to import al of these addresses to your subscriber database.

o PONPE

© N
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12. Impo'rti ng from Microsoft Outlook will have asimilar procedure. You just need to
locate the method for exporting the Address Book.

How can | import addresses from Y ahoo?
SOLUTION - to import the addresses in your Y ahoo address book, follow these steps:

1. Loginto your Y ahoo account.

2. Click onthe“Addresses’ link on the left side to open the address book.

3. At the bottom, undernesth the address list, click on the link labeled
“Import/Export”.

4. On the Import and Export page, export the address book using the Y ahoo! CSV
format. Click the “Export Now” button next to this prompt.

5. Savethisfile and then open it in Microsoft Excel (or similar program). The e-mail
addresses from the address book are listed in a column titled “E-mail”. These are
the addresses that you can import into your newsl etter account.

6. Highlight and copy (CTRL+C) all of the addresses in this column to the clipboard
(excluding the label at the top).

7. Loginto your newsletter account.

8. Click on the “Subscribers’ link at the bottom of the Main Menu.

9. Click onthe“IMPORT SUBSCRIBER LIST".

10. Put the cursor in the E-mail Addresses box and paste the e-mail addresses you
copied (CTRL+V).

11. Optionally specify asub-list or short source code.

12. Click “Submit” to import al of these addresses to your subscriber database.

When importing a subscriber record, what happensif therecord already exists?

SOLUTION - the existing record will be updated with the new information you supply.
If, for example, the current record has e-mail address, first name, last name and the new
imported record (with a matching e-mail address) includes only a phone number, then the
existing record will be updated and the phone number will be added, leaving the first
name and last name intact.

Importing a tab-delimited file

SOLUTION - uploading your e-mail addresses and other member information is easy.
There are many fields of information you can associate with a subscriber, including 10
custom fields. Thiswill help you track and personalize messages as well as create sub-
lists based on field criteria.

For example, you may want to just mail to membersin asingle state. Y ou can go to the

subscriber area, choose “SEARCH AND MANAGE SUBSCRIBER LIST”, and then
create anew list based on the State field. Y ou can of course do thiswith any field.
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Hereisalist of al the available fields you can upload:

Salutation (Mr., Mrs,, Ms,, etc.)
FirstName
MiddleName
LastName
Company/Organization
Title
Addressl
Address2
City
State/Region
ZIP

Country
Phone

Fax
Customl
Custom2
Custom3
Custom4
Custom5
Custom6
Custom?7
Custom8
Custom9
Custom10

To upload and import this data, you must first put the datainto atab-delimited text file.
Many database systems provide an easy way to do this. If you are unsure, the easiest way
to create atab-delimited file is to open your datafirst in Microsoft Excel. Then, select
“Save” from the File menu and choose “ Tab Delimited” asthe file format.

Once you have created your tab-delimited file, you need to upload it to your account:

1. From the Main Menu choose the “ Subscribers” link.
2. Then choose the “IMPORT SUBSCRIBER LIST” link.
3. UseMethod 1. Click the “Browse” button and find the tab-delimited file you
created. Then, click “Continue”.
4. On the next page, “(Step 2) Subscriber Import Analysis’, you will see alist of
field mappings.
Each column represents afield in the import file. Review the results and correct any
assignmentsif necessary. If you do not need to import a specific column from the tab-
delimited file, select “Unknown” for that column.
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The import procedure automatically prevents duplicate records from being added to your
list and updates the information associated with any pre-existing subscriber record with
the imported values. There are two ways the records you are importing can be
synchronized with the subscriber list in your account. Y ou can:

Add new subscribers, update existing subscribers.
Add new subscribers, update existing subscribers, remove subscribers not in the imported
file.

Y ou can also reactivate subscribers in import file who previously opted out, but thisis an
advanced feature that can override the opt-out request of your subscribers. Use this only

to obtain an exact synchronization of your subscriber database and your account without
using the opt-out protection feature.

Optionally, choose what sub-list should contain these subscribers and specify a source
code if you would like to track the progress of these subscribers as a group. Once you are
satisfied, click “Continue”’. The import will now run and you will see a message that
indicates the process has begun. This can take from afew seconds for alist of 50 or less,
to 20-30 minutes for lists of 10,000 or more.

How do you handle duplicate e-mail addr esses?

SOLUTION - when you upload a subscriber list, duplicate subscriber records are
automatically removed. The subscriber database in your account requires each record to
have a unique e-mail address.

If you send your newsletter by e-mail to your complete list, each recipient will get only
one copy of the e-mail. Sometimes, asingle recipient may have two different e-mail
addresses that lead to the same e-mail box. In this case, it might appear that one person
has received two copies of the same message when in fact there are two different
messages being sent to two different e-mail addresses.

IMPORTANT NOTE: When using sub-lists, it is possible for one subscriber to appear in
two or more sub-lists. If thisisthe case, then sending your newsletter to each of these
sub-lists separately would cause duplicate messages to be received.

For example, a subscriber named George Smith would appear only once in your database
but might be assigned to sub-list 1 and sub-list 3. If you send your newsl etter to sub-list 1
and then to sub-list 3, George Smith would get the newsletter twice.

To prevent subscribers from being in multiple sub-lists at the same time, make sure to
check the box labeled “Make unique to thislist” before performing an import. In
addition, you can use the Search and Manage Subscribers page to manipulate your sub-
lists by moving subscribers from one sub-list to another.
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What arethese “ Excluded” or “Known Undeliverable’” subscribers?

SOLUTION - one of the built-in functions of IMN’s e-mail system is a Bounce Manager
feature that excludes active subscribers who are identified as undeliverable from future e-
mail jobs. The Bounce Manager identifies e-mail that is returned without delivery for
reasons such as full mailboxes, people on vacation, bad addresses, or for unknown
reasons. In this article, we'll get into alittle more detail about some of the bouncesin the
bad address category, including why they are excluded even if you don’t remove them,
and how to find and manage them.

Not al “bad addresses’” are excluded.

The term “bad address” may actually indicate one of several scenarios. Depending on the
situation, they may or may not be excluded from future mailings, as described below.

The most common bad address is when the domain portion of the e-mail was valid but an
e-mail server in that domain responded to our attempt to send by saying, in effect,

“there’ s no such address here.” Another scenario is that the domain itself doesn’t seem to
exist, or can’'t be reached. A third possibility is that there does not appear to be a mail
server in the domain.

These last two bounce categories are potentially temporary conditions and these
subscribers will not be excluded from future e-mail jobs. However, once the Bounce
Manager processes a“No User” bounce, asin thefirst case, it updates that record in your
account’ s subscriber database and it will exclude these subscribers from future mail jobs.

A subscriber record may aso be excluded if an “administrative address’ isimported viaa
file upload and import. These administrative e-mails have addresses that begin like
root@, postmaster@, and administrator@. These addresses are excluded by default
because only very rarely are these kinds of addresses used for receiving messages. More
often, they are simply used for administrative purposes. M essages sent to them, in
particular non-system related messages, are treated as abuse by most |SPs and networks
and the managers of these domains will typically blacklist the source. These addresses are
excluded by default to prevent this. If you are certain thisis the address you should be
sending to, you can re-activate the address after it isimported.

If you regularly use the Bounce Manager interface to clean your list of bounces, you may
not see many of these exclusions when sending e-mail. But keep in mind, bounced
subscribers with “bad addresses” are still considered to be active subscribers until you
take some sort of action to remove them, with either the Bounce Manager or with the
“Search and Manage” option using the process described below.

How do | find all these excluded “bad addresses’ ?
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To find excluded bad addresses, go to the “ Search and Manage” interface on the main
Subscriber Menu. There, under the * Select subscribers that” portion of the screen, you
can keep the default of “all active subscribers” in the “are found in” field or you can use
any of the other search criteriato select the subscribers you want to find excluded
addresses for.

Once you have your criteria selected, go to the“And is’ drop-down menu that defaults to
“Active, not removed.” Change this option to “Marked as undeliverable.” By choosing
this option, you will be able to find any of the “bad address” e-mailsin your subscriber
base. Farther down, under the “ And then” portion of the screen, you can select theradio
button option designating what you wish to do with these subscribers. Initially, you may
want to select “View them,” but eventually, once you' ve looked them over, you may
want to “Permanently delete from all lists, but remember as opted out.” By choosing this
option, the names will still be in your database, but they will no longer be considered
active and they will be excluded from your future mailings.

But | know this one address is gopod—what now?

In extremely rare cases, good e-mail addresses may be excluded because of arare mis-
configuration on the recipient’s mail server. If this should occur, you can “unexclude’ an
address in the system by searching for the address (either in the “ Search and Manage”
interface, or in the “Quick Tasks’ area on the main Subscriber Menu), edit that
subscriber’ s properties, and then save them. Once a subscriber record is re-saved, this
will remove the exclusion on this address so that the system will try it again with any new
information you may have provided.

Sending the Newsletter

How can | changethe FROM address of the newsletter and the SUBJECT?

SOLUTION - yYou can easily specify the e-mail address and name of the person or
company sending the e-mail (the reply address) when you prepare the newsl etter to be
sent by e-mail.

Click “SEND AS E-MAIL” on the menu. Thiswill take you to the E-mail Broadcast
page. In the FROM: section of the page, you will find an e-mail address box and afull
name box. Thisiswhere you can specify the return address and the complete sender’s
name.

TIP: Don’'t use an e-mail account from an anonymous e-mail provider such as Hotmail or
Y ahoo. Your e-mail will be blocked by our SPAM protection system.
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How does the Bounce Manager work?

SOLUTION - when an e-mail message is delivered, special header information is added
to the top of the message. Thisinformation tells amail server or an e-mail program who
sent the message, where it came from, and where to send replies.

The FROM header identifies the sender and the REPLY TO header identifies where
replies can be sent. The TO header identifies the e-mail address of the recipient. The e-
mail address is composed of a user name and a domain name, separated by the @ sign.

When an e-mail is sent, it travels from mail server to mail server until it reachesits
destination. The destination is the mail server that collects mail for the domain found in
the TO address. Then, thismail server looks to see if the specified user existsinternally
and if so, delivers the message to that user’s mail box. If the user does not exist, the mail
server will send a special notification (bounce message) back to the person in the FROM
address. It is aso possible to receive a bounce message from the first server the message
isdelivered to before it even reaches its destination. Thisis caused when the domain
portion of the e-mail itself is either incorrect or permanently or temporarily unavailable.

When bounce reporting is turned on, a special FROM address is constructed so that all
bounce messages that arrive are collected by our software and not your e-mail program.
We then take these bounce messages and search through them to determine the cause of
the bounce. This process is made difficult due to the fact that every different type and
configuration of mail server returns adifferent type of bounce message.

Once scanned, the bounce messages are classified and uniquely identified in the bounce
database. In addition to the bounced e-mail address name, a count is kept to indicate how
many times a particular e-mail has bounced—for whatever reason.

A full bounce report can take days to assemble. If amail server is having problems
delivering a message to adomain, it may try for several daysto deliver the message and
then return the bounce message when it gives up.

Which format will subscribersreceive by default: HTML or plain text?

SOLUTION - if not otherwise specified, the format preference for each subscriber is
“Unknown”. This means when the newdletter e-mail is sent, it is delivered using a multi-
part format that includes both aplain text and an HTML version. If the subscriber’s e-
mail program supports HTML, the HTML version will be displayed. If the e-mail
program does not support HTML or the mail gateway does not allow HTML to pass
through, the plain text version will be received.

Over time, subscribers can specify their desired format: HTML or plain text. In this case,
only the preferred format will be e-mailed to the subscriber.
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NOTE: In some cases, e-mail programs or mail gateways will take the HTML portion of
amulti-part message and try to interpret its contents as a plain text message. There are
also e-mail programs that do not fully support HTML e-mail, but think that they do. In
these cases, subscribers may receive an e-mail that is poorly formatted. To solve this
problem, change the format preference for these specific subscribersto “Plain Text”.

How do | e-mail the newdletter for review without making it public?

SOLUTION - under “[Issue Properties]”, change the status of the issue you want to send
for review from “ Approved” to "Pending”, then post the newsletter to the Web. This
will prevent anyone from seeing it unless they have an e-mail with alink to it.

When you are ready to publish the newsletter to everyone, remember to change the status
back to “ Approved”.

When problems occur with HTML e-mail

SOLUTION - sending HTML e-mail messagesis an imperfect science. There are
hundreds of different e-mail programs and mail server programsinstalled around the
world. Each offers different capabilities and levels of HTML e-mail support. Luckily,
most of these systems support the decoding and display of HTML formatted e-mail
messages.

We use various techniques to make sense out of all of this and deliver the best e-mail
format to the widest audience. These techniques include probing, multi-format encoding,
and support for user preferences.

Despite the use of these techniques, you may occasionally receive a complaint from a
recipient who is unableto properly read the HTML e-mail you deliver. In these cases, it
islikely the recipient is using an older e-mail platform that isincompatible with the
various probes and multi-format messages we send AND does not display HTML e-mail
correctly. Below you will find further information regarding these systems. In each case,
the quickest and easiest solution to the problem isto change the format preference for the
subscriber to “Plain Text”.

Eudora and L otus Notes

Eudora and Lotus Notes are common e-mail clients. Unfortunately, certain earlier
versions of these programs do not adhere to current e-mail standards.

The details are a bit complicated, but, for example, Eudora 4.0 (or earlier) supportsonly a
simple form of HTML lacking many layout controls like tables. Later versions of Eudora
(after version 4.0) work much better. If these subscribers have been ableto receive

HTML in the past, they are probably receiving simpler HTML than that produced by the
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cover page you send. The other aternativeisto e-mail out HTML paragraphs (instead of
the cover page). You will see this option on the top of the “Send as E-mail” screen.

Lotus Notes sometimes strips out all the HTML and images instead of showing the plain
text version. It aso depends on how the Lotus Notes server and mail gateway are
configured (see below).

For additional information about known problems with Lotus Notes (and possible
solutions that can be implemented by the recipient’s IT department), see the following
articles:

Background and Current Status of NotessDomino R5 Native Support of HTML and
MHTML Rich Text Format
http://www-1.ibm.com/support/docview.wss?uid=swg27002941

Domino R5 Converts HTML into Misaligned Formatting with “[IMAGE]” Throughout

Message
http://www-1.ibm.com/support/docview.wss?uid=swg21087057

Recipientsin R5 & Group Tools Environment Receive Internet Mail with Misaligned
Text & “[IMAGE]”
http://www-1.ibm.com/support/docview.wss?uid=swg21086834

If your subscriber’s IT department is unable to correct this situation, the best adviceisto
change the e-mail format preference for subscribers using these e-mail programsto “Plain
Text”. The plain text message will then include links to the HTML version hosted online
so that the full color version of the newsdletter is available to everyone.

Mail Gateways and Microsoft Exchange

In addition to e-mail programs, e-mail servers and gateways can cause trouble with
HTML e-mail. These are the systems responsible for passing e-mail messages from one
machine to the next over the Internet and within a company. The gateway is usualy
responsible for providing security (also known as afirewall) and an interface between
internal and external e-mail systems.

One thing we have seen gateway systems do is intercept an incoming HTML message
and change the information it contains. This happens occasionally and can cause
unpredictable results. In addition, some gateways will not support multi-part e-mail
messages correctly and will end up sending the compl ete message through without the
proper encoding.

Subscribers who receive e-mails passed through these gateways may see a garbled e-mail
message or may only receive the plain text version. Onething to try in these casesisto
force the e-mail format being sent to HTML. Thisis done by changing the subscriber’s
format preference from “Unknown” to “HTML”. If you are sending a test message, this
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can be tricky, since there is no way to force the HTML format. In this case, the e-mall
address you are testing should be placed in a sub-list with the e-mail format of this record
set to HTML. Y ou can then send your e-mail to this sub-list.

AOL

AOL 5.0 or earlier also provides limited HTML e-mail support. Recently, AOL improved
HTML e-mail support with new versions 6.0 and 7.0 of its client software and the
AOLANnywhere Web service. Because of this mixture of supported and non-supported
users, we have built specia functions to handle subscribers who use AOL e-mail. A
special AOL e-mail version is always created and sent to these users when you send your
newsletter. We also perform special probing to seeif we can determine which AOL
version is being used. This probing works most of the time and if we can positively
identify an AOL 6.0 or AOL 7.0 user, they will be sent and will receive the complete
HTML version of your e-mail. In all cases, AOL users see the best version of the e-mail
that can be delivered to them.

Which e-mail programs support HTML and which do not?
SOLUTION

HTML: With graphics and design

Compatible with:

AOL 6.0 or higher

Netscape Navigator e-mail
Netscape Communicator e-mail
Microsoft Internet Explorer 4.0 or higher
Microsoft Outlook

Microsoft Outlook Express
EudoraHTML

Hotmail

Mailcity

Y ahoo Mall

Rocketmall

Text only: No graphics, all the same font

Compatible with:

AOL 5.0 or lower

QuickMail

Eudora Lite and pre-4.2

Lotus Notes/CC:Mail (depends on install)
Microsoft Internet Mail
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Pegasus Mail
Microsoft Mail
Claris Emailer
Prodigy
Compuserve
Mail Excite

How many times do you attempt to send an e-mail before you report it as bounced?

SOLUTION - the answer to this depends on how the message is bouncing. If itisaso-
called “Hard Bounce’, where the mail service at the destination domain actually reports
that there is no such address, then the system immediately stops sending the e-mail, and a
bounce message is returned.

A retry of the e-mail send is done when communication between mail servers cannot be
established, resulting in a“Soft Bounce”. This can occur for many reasons and is very
common on the Internet today. For example, if the AOL mail servers are busy, the mailer
may need to retry sending the message several times before it is accepted. The ability to
retry delivery of an e-mail is a necessary and required process for the successful
operation of amailer.

While it might be abest practice to attempt delivery on an e-mail message at least 4 or 5
times, the iMakeNews mailer is configured to do this much more than that. Our mailer
will attempt delivery every 5 minutes for up to 72 to 108 hours for a possible minimum
total of 864 tries, all the way up to 1296 tries. If at the end of this process, the mailer is
not able to successfully connect to the mail server destination, it will return the outgoing
message as a “bounce” that appears in the bounce manager under the “Unknown”
category.

Every e-mail that ends up in the bounce manager has gone through the same process.

Reporting

When isan e-mail considered “open” ?

SOLUTION - it depends on the configuration of the recipient’s e-mail program and how
they review their e-mail. If the program is configured to use a Preview Pane (like Outlook
or Outlook Express), then when a message is highlighted in the Message List, the e-mail
will be automatically displayed and will be tracked as “open”. If the Preview Paneis not
being used or if the message in the Message List is never highlighted or double-clicked,
the “open” will not occur.
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Thetrick that is used to track the open rateis actualy quite simple. A 1 x 1 pixel graphic
is called through an embedded HTML image tag hidden somewhere within the e-mail
message. When thisimage is called, a routine on the tracking server sees this and counts
thisas an “open”. So in order for an e-mail message to be considered “open”, it must be
displayed through awindow that can show embedded graphics.

The open rate is atricky statistic when dealing with HTML e-mail. It’sthe statistic every
marketer would love to have, but it is hampered by the technical realities of the medium.
For instance, it is not possible to know the open rate for e-mail messages received in
plain text format. If your list management solution allows subscribers to choose their
preferred e-mail format then you might be able to segment the list to those wanting plain
text and those wanting HTML (and no format unknown). Then, if you send only HTML
to the people who want HTML and then check the open rate for thislist, you will have a
more relevant statistic.

Otherwise, if you are unable to explicitly segment your list according to format, the Open
Rate statistic becomes only a more general measure of user activity. The emphasis then
falson thetraditiona Click-Through Rate, which remains one of the best ways to
measure user interest and response.

Why does a particular subscriber appear to have opened the e-mail many times?

SOLUTION — sometimesiit will appear asif a particular subscriber has opened the e-mail
many more times than anyone else. This could be 20, 50, 100, or even 1000 times. There
are several reasons why this can occur:

The e-mail programis opening the e-mail as the subscriber scrolls from one message to
another. The e-mails opened statistic measures the number of times the e-mail is opened
in the subscriber’ s e-mail program. If the subscriber is scrolling back and forth through
their email with the contents of the e-mail showing in a“preview” pane within their e-
mail program, then each time they pass over the e-mail it will be registered to the system
asan “open”. Unfortunately it is hard to distinguish the difference between a passing
glance and adeliberate open. In this case, note that it is more important to recognize the
unigue people who are opening the e-mail instead of how many times they are opening it.

The e-mail has been forwarded by this subscriber to a mailing list or to everyonein a
particular company or department. Because all of the people who have received this e-
mail are receiving the e-mail that has been encoded for this specific subscriber, al of the
“open” tracking is being recorded under this subscriber in the activity report.
Unfortunately, there is no way to prevent the HTML message from being forwarded and
itis hard for us to distinguish between the origina recipient and all the people receiving
the same forwarded e-mail.
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What isagood click-through rate?

SOLUTION - the click-through rate depends on the content of the e-mail, the audience,
and the format. However, HTML e-mail click through rates can be 5 percent and as high
as 40 percent.

Here are some examples: A recent issue of our own newsletter has a*“ Click from E-mail”
statistic of 22 percent. A daily newsletter that was sent by our service (on aFriday) had a
10 percent rate. Another recent customer (a software company) had a click-through rate
of 17 percent.

NOTE: When reviewing statistics, consider how long it has been since the mailing has
been delivered. Not all the data comesin at once since not all of your subscribers are
online. It usually takes at least aweek to get the full picture.

Hereis an interesting article you might find helpful:
http://www.clickz.com/em_mkt/opt/article.php/998911

What do these reporting terms mean?

SOLUTION - hereisalist of the key metrics being tracked for each issue/mailing:

E-mails Sent

E-mails Delivered

Bad Address

Mail Box Full

Hits, Total

Clicks, Total and Unique

Opens, Total and Unique

Visitsto Microsite, Total and Unique
Referrals, Total and Unique
Referral Actions, Total and Unique
Identified Visitors

Unidentified Visitors

Subscribers Added

Subscribers Removed

Abuse Complaints

E-mails Sent vs. Delivered

E-mails Sent = Total number of e-mails that were sent to the mailer to be distributed

E-mails Delivered = Sent — Bad Address — Mail Box Ful
This statistic does not include unknown bounces or vacation messages.
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Bounces
A bounce occurs after an attempt is made to deliver an e-mail but the email is not
deliverable and/or causes an automated response. There are four categories into which
bounces are classified:

Bad Address
User addressis not valid, or domain does not exist.

Mail Box Full
Email box has reached its limit.

Vacation

Systems vary when handling this. Some return vacation message back to the system via
the FROM address, and others send vacation notification back to the sender viathe
REPLY-TO address.

Unknown
Messages that came back but the system could not properly identify and classify them.

Only the Bad Address and Mail Box Full bounce messages are definitive indicators that
an e-mail did not get through. V acation messages usually indicate that the e-mail was
received but not read. Unknown bounces can occur for anumber of reasons; however,
there was not enough information in the message for the system to automatically
determine the cause. This can happen frequently—there is no standard mechanism for e-
mail serversto report bounces, and automated messages can often be sent for situations
other than unknown addresses or mail box quota problems.

Hits, Total and Unique
Hits, previously known as page views, describe all actions that can occur within the e-
mail or microsite.

Hits (Page Views) = Clicks + Opens + Microsite Visits + Referrals + Referral Actions

Total Hits= All actions, with repeats by same subscriber
This statistic represents all of the activity occurring on a particular issue/mailing.

Clicks, Total and Unique
A click occurs when a subscriber clicks alink on the e-mail message.

Total Clicks = All clicks, with repeats by same subscriber
This number represents each individual click on any link in the e-mail, no matter how
many clicks the same person has made.

Unique Clicks = Distinct clicks with no repeats by the same subscriber
Thisisthe number of individual subscribers that have clicked at least once on any link in
the e-mail.
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NOTE: If the e-mall is posted to a newsgroup or passed aong to other people through e-
mail forwarding or internal distribution lists, additional clicks will be attributed to the
original subscriber.

Opens, Total and Unique
An Open occurs when an e-mail message has been opened or viewed in an e-mail
program.

Total Opens = Each time the e-mail is opened or previewed in the e-mail program

Unigue Opens = Only the first time the e-mail is opened by each subscriber

NOTE: The Open statistic is only reported through e-mails sent and received with the
HTML e-mail format and through HTML-compliant e-mail programs.

If eemall is passed along, additional opens will be attributed to the original subscriber and
will show in the Total Opens statistic. Only the open from the first subscriber will be
counted in the Unique Opens statistic.

Visitsto Microsite, Total and Unique

Thisisthe number of pages viewed on the microsite. The statistic only includes pages
hosted on the system. If apage is copied to another server, additional microsite visits will
be recorded as part of the total.

Total Visitsto Microsite = All pages viewed, with repeats by the same subscriber

Unique Visits to Microsite = The distinct visits to the microsite, with no repeats from the
same subscriber
Thisisthe number of unique subscribers that have visited the microsite at |east once.

Referrals and Referral Actions
The Referrals statistic is the number of people that have filled out the “ Refer a Friend”
form attached to a newsletter.

The Referral Actions statistic is the number of people that clicked thelink in the referral
e-mail.

|dentified Visitors and Unidentified Visitors

An Identified Visitor is a known subscriber. This person may have come from an e-mail
or filled out the subscription form. Each subscriber that has taken at |east one action with
the issue/mailing is considered an Identified Visitor.

Unidentified Visitors are people who are not subscribers. They may have come from a
search engine or alink on a Website. The system has no way of determining who these
people are and is unable to find them in the subscriber database of the account.
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Subscribers Added

Thisisthe number of subscribers who have been added due to a particular issue or
mailing through the subscribe box associated with the account. This value does not
include subscriber records added viaimport or other administrative tools. New
subscribers who cannot be associated with a particular issue or mailing are also
excluded fromthis statistic.

Subscribers Removed

Thisisthe number of subscribers who have removed themselves, either through the
subscription form, the opt-out link at the bottom of the e-mail message, or through an
abuse complaint due to a particular issue or mailing. This value does not include
subscriber records removed viaimport, search and manage, or other administrative tools.
Subscribers who cannot be associated with a particular issue or mailing are also
excluded from this statistic.

Abuse Complaints

Thisisthe number of people that believe your e-mail to them is spam. Complaints can
come directly from the user or through an 1SP, and will be associated with the mailing
that generated the complaint.
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